**MPLAB Harmony Graphics Composer User's Guide**

This section provides user information about using the MPLAB Harmony Graphics Composer (MHGC).

**Introduction**

This user's guide provides information on the MPLAB Harmony Graphics Composer (MHGC), also referred to as the graphics composer, which is included in your installation of MPLAB Harmony. MHGC is tightly coupled with the Aria User Interface Library to facilitate rapid prototyping and optimization of the application's graphical user interface (GUI).

**Description**

The MPLAB Harmony Graphics Composer (MHGC), also referred to as the graphics composer, is a graphics user interface design tool that is integrated as part of the MPLAB Harmony Configurator (MHC). MHGC is tightly coupled with the Aria User Interface Library to facilitate rapid prototyping and optimization of the application's graphical user interface (GUI). The tool provides a "What you see is what you get" (WSYWIG) environment for users to design the graphics user interface for their application. Refer to [Volume V: MPLAB Harmony Framework Reference > Graphics Library Help > Aria User Interface Library](#) for more information.

The MPLAB Harmony Graphics Composer (MHGC) Tool Suite and the Aria User Interface Library provide the following benefits to developers:

- Enhanced User Experience – Libraries and tools are easy to learn and use.
- Intuitive MHGC Window Tool – Flexible window docking/undocking. Undo/Redo and Copy/Paste support. Tree-based design model. Display design canvas control including zooming.
- Tight Integration Experience – Graphics design & code generator tools are tightly integrated, providing rapid prototyping and optimization of look and feel.
- Powerful User Interface (UI) Library – Provides graphics objects and touch support.
- Multi-Layer UI design – Supported in the MHGC tool and Aria Library.
- Complete Code Generation – Can generate code for library initialization, library management, touch integration, color schemes and event handling with a single click.
- Supports Performance and Resource Optimization – Draw order, background caching, and advanced color mode support improve performance.
- Resource optimization – Measures Flash memory usage and can direct resources to external memory if needed. Global 8-bit color look-up table (LUT) supports reduced memory footprint. Heap Estimator tool, which helps to manage the SRAM memory footprint.
- Text localization – Easily integrate international language characters into a design and seamlessly change between defined languages at run-time.
- Easy to Use Asset Management – Tools provide intuitive management of all graphics assets (fonts, images, text strings).
- Image Optimization – Supports cropping, resizing, and color mode tuning of images.
- Expanded Color Mode Support – The graphics stack can manage frame buffers using 8-bit to 32-bit color.
- Powerful Asset Converter – Inputs several image formats, auto converts from input format to several popular internal asset formats, performs auto palette generation for image compression, supports run-length encoding. Supports automatic font character inclusion & rasterization.
- Event Management – Wizard-based event configuration. Tight coupling to enable touch user events and external logical events to change the graphics state machine and graphics properties.
- Abstract Hardware Support – Graphics controllers and accelerators can be added or removed without any change to the application.

**Glossary of Terms**

Throughout this user's guide the following terms are used:

<table>
<thead>
<tr>
<th>Acronym or Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>A specific task to perform when an event occurs.</td>
</tr>
<tr>
<td>Asset</td>
<td>An image, font, or binary data blob that is used by a user interface.</td>
</tr>
<tr>
<td>Event</td>
<td>A notification that a specific occurrence has taken place.</td>
</tr>
<tr>
<td>Resolution</td>
<td>The size of the target device screen in pixels.</td>
</tr>
<tr>
<td>Screen</td>
<td>A discreet presentation of organized objects.</td>
</tr>
<tr>
<td>Tool</td>
<td>An interface used to create objects.</td>
</tr>
<tr>
<td>UI</td>
<td>Abbreviation for User Interface.</td>
</tr>
<tr>
<td>Widget</td>
<td>A graphical object that resides on the user interface screen.</td>
</tr>
</tbody>
</table>

**Graphics Composer Window User Interface**

This section describes the layout of the different windows and tool panels available through MHGC.
**Description**

MHGC is launched from the MHC toolbar Launch Utility menu. Launching the Graphics Composer creates a new screen. Shown below is the MHGC screen for the Aria Showcase demonstration. (If you don’t see this screen layout, reset the screen by selecting *Window > Reset Dock Areas* from the window’s menus.)

**Panels**

By default, there are five active panels and one minimize panel on this screen:

- **Screen Designer** – Shows the screen design for the selected screen. Tabs on the bottom of the Screen Designer panel show the available screens.
- **Tree View** – Shows the layer and widget hierarchy for the current screen.
- **Screens** – Manages screens in the application.
- **Schemes** – Manages coloring schemes in the application.

- **Widget Tool Box** – Available graphics widgets are shown on this panel. Widgets are added to the screen by selecting an icon and dragging or clicking. Widget properties are discussed in the Widget Properties section below.
- **Properties Editor** – All properties for the currently selected object are shown in this panel.

- **MHGC Output console** is parked at the bottom of the Screen Designer window. This console panel can be used to debug problems when the Graphics Composer boots up or during its operation.

Each of the panels has a window tool icon at the upper right corner. Minimizing a panel parks it on the screen just like the Output Console. Undocking the panel creates a new, free floating window. Redocking returns a previously undocked window to its original location on the Screen Designer window.

*Note:* In v2.03b of MPLAB Harmony, a third tab named Options, along with Screens and Schemes was available. These properties are now located within the *File > Settings* menu.
When a panel is undocked, its edges become active and support moving or manipulating the panel as an independent window.

**Tool Bar**

There are 18 tool bar icons on the Screen Designer Window, as described in the following figure.
Create New Design brings up a New Project Wizard dialog that allows you to select anew the screen size, color mode, memory size, and project type. This will erase the currently displayed design.

Save Design saves the current design.

Undo and Redo manipulate changes in the screen design.

Cut/Copy/Paste support the manipulation of graphics objects (widgets).

Canvas Size Dialog brings up a dialog window allowing changes in the pixel width and height of the Screen Designer panel. (Note: Dimensions smaller than the display’s dimensions are ignored).

Center View centers the panel’s view of the screen.

Zoom In and Zoom Out allow you to change the scale of the Screen Designer’s display of the current window. Currently this only supports coarse zooming (powers of two zooms in and out).

Toggle Line Snapping enables/disables line snapping when moving objects (widgets).

Show Grid turns the Screen Designer pixel grid on/off.

X and Y Grid Size adjust the pixel grid.

Grid Color selects the pixel grid color.

Toggle Object Clipping turns object clipping on/off.

Toggle Screen Info turns the display of screen information (X and Y axes) on/off.

Select Text Preview Language changes the language used on all text strings shown, when the application supports more than one language.

**Screen Designer Window**

Most of the work of the MPLAB Harmony Graphics Composer is done using the Screen Designer. This section covers the basics of how a graphical user interface is designed using the screen designer.

**Description**

The following figure shows the Screen Designer window for the Aria Quickstart demonstration, with the pic32mz_ef_sk_meb2 configuration selected. (Load whatever configuration belongs to your board and follow along.)
The pixel dimensions of the display (480x272) are determined by the MHC Display Manager. Other configuration in Aria Quickstart can have different size displays (such as: 220x176, 320x24, or 800x480).

This demonstration has three widgets: a label containing the title string at the top, an image of the MPLAB Harmony logo in the middle, and a button containing the text string “Make changes. Generate. Run.” at the bottom. The label widget’s text string was first created using the String Assets window before it was assigned to the label widget. The image assigned to the image widget was first imported using the Image Assets. The string embedded in the button widget was also created using the String Assets window before it was assigned to the button widget.

The Tree View panel organizes the display’s widgets into groups using layers. Every display has at least one layer and complex designs can have many more. Within the tree view, the order of layers and the order of widgets within a layer determine the draw order. Draw order goes from top to bottom. Top-most layers and widgets are drawn first and bottom-most are drawn last. Controlling draw order is one of the ways to improve graphics performance by minimizing redrawing.

Since the location of every widget within a layer is relative to the layer, you can move a layer’s worth of widgets by simply moving the layer. Layers also provide inheritance of certain properties from the layer to all the layer’s widgets.
Exploring the Screen Designer Window

We can add another widget to this screen by launching the Widget Tool Box panel into a separate window.

[Image: Widget Tool Box]

Next, drag a circle from the tool box onto the display. Find a place on the display for this new widget. Besides dragging widgets onto the display, you can click on a widget in the Widget Tool Box, converting the cursor into that widget, and then click on the screen to drop the widget in place.

[Image: Display with circle]

Your display should now look like the following figure.

[Image: Display with circle and properties]

Note how the Tree View panel now shows the widget you just added.

Launch the Properties Editor for the circle.

Next, change the fill property on the circle from “None” to “Fill”.

[Image: Properties Editor with fill property]
Note: If the properties in the Properties Editor shown are not for CircleWidget1, click on the circle widget to change the focus of the Properties Window.

When done, the screen should now appear, as follows.

Turn on Line Snapping, which enables drawing guides to assist in aligning widgets on the display.

Next, turn on Object Clipping, which allows you to see how widgets are clipped by the boundaries of the layer that contains them. Note: Clipping applies to layers, which can be smaller than the display.

To delete a widget, select the widget and press Delete on your keyboard or use the delete icon ( ) on the Tree View panel.

For more hands-on exploration of graphics using the Aria Quickstart demonstration, see Volume 1: Getting Started With MPLAB Harmony > Quick
Menus

This section provides information on the menus for the MPLAB Harmony Graphics Composer screen.

Description

File Menu

New – Same as the Create New Design tool icon.
Save – Same as the Save Design tool icon.
Save As – Supports exporting the design under a new name.
Import - Reads in (imports) a previously exported design.
Export – Same as Save As.
Settings – Brings up Project and User Settings dialog, including:
• Project Color Mode - How colors are managed
• Using a Global Palette
• Show Welcome Dialog
• Pre-emption Level – Allows for sharing of the device’s cycles with other parts of the application
• Hardware Acceleration – Is graphics hardware accelerator enabled in software?
Exit – Closes the MHGC window and exits

The choices for Project and User Settings > Project Color Mode are:
• GS_8 - 8-bit gray scale
• RGB_332 - Red/Green/Blue, 3 bits Red/Green, 2 bits Blue
• RGB_565 - Red/Green/Blue, 5 bits Red, 6 bits Green, 5 bits Blue
• RGBA_5551 - Red/Green/Blue/Alpha, 5 bits Red/ Green/Blue, 1 bit for Alpha Blending
• RGB_888 - Red/Green/Blue, 8 bits Red/Green/Blue
• RGBA_8888 - Red/Green/Blue/Alpha, 8 bits Red/Green/Blue/Alpha Blending
• ARGB_8888 - Alpha/Red/Green/Blue, 8 bits Alpha Blending/Red/Green/Blue

Ensure that the Project Color Mode chosen is compatible with the display hardware you are using; otherwise, the colors shown on the display will not match those shown on the Graphics Composer Screen Designer.

Using a Global Palette enables frame buffer compression for applications using the Low-Cost Controllerless (LCC) Graphics Controller.

If Using a Global Palette is enabled, the following warning appears.
If Show Welcome Dialog is enabled, the following welcome screen appears when launching MHGC.

Note: If you are not creating a new project you can ignore this window.

When the Preemption Level is set to zero, all dirty graphics objects are refreshed before the graphics process relinquishes control of the device. (Dirty means needing a redraw.) With the level set to two, graphics provides maximum sharing with the rest of the application, at the cost of slower display refreshes. A level of one provides an intermediate level of sharing.

The Hardware Acceleration check box determines whether graphics uses the device’s built-in graphics hardware accelerator in software.

Note: You must also specify the graphics hardware accelerator in the MPLAB Harmony Framework Configuration within the MHC Options tab. If the host device lacks a graphics processor, you will see a warning message when you try to select a processor that does not exist on your device.
Edit Menu

This menu implements the same functions as the first seven tool icons.

View Menu

This implements the same functions as the remaining tool icons.

Asset Menu

These menu features are discussed in Graphics Composer Asset Management.
Tools Menu

The Event Manager, Global Palette, and Heap Estimator are discussed in MHGC Tools.

Window Menu

Selecting Console opens the Output Console for the Graphics Composer. This console panel can be used to debug problems when the Graphics Composer boots up or during its operation.

Selecting Reset Dock Areas restores the MHGC panel configuration to the default setup by redocking all of the panels that have been undocked into separate windows.

Tree View Panel

The organization of application widgets and layers, including draw order, is managed using this panel.

Description

Example Tree View

The following Tree View (from main screen of the Aria Coffee Maker demonstration shows the tree structure for a screen with three layers.
**Drawing Order and Parent/Child Relationships**

The Graphics Composer Tree View panel allows you to organize the widgets per screen in the desired drawing order (z-order). It also allows for the user to organize the widgets into parent–child hierarchies to allow for the paint algorithm to draw the groups together in event of motion or re-draw. Please note that this does not associate or group the widgets by functionality. (Example: a group of radio buttons might not belong to a common parent on the screen.) This parent-child relationship is limited to the widgets location on the screen, motion on the screen and the drawing order on the screen. (Exceptions to this general rule are the Editor > Hidden, Alpha Blending properties, and layer single versus double buffering. These apply to the parent and all the parent's children.)

The tree is traversed depth-first. This means that the z-order goes background (bottom of z-order) to foreground (top of z-order) as we go from top to bottom in the list of widgets, i.e., `ImageWidget1`, is the widget at the bottom of the z-order and the `PanelWidget1` is the topmost widget on the z-order. The tree structure can be arranged and modified by dragging the widgets and releasing it under the desired parent/child. Also, the list can be modified by using the up/down arrows provided at the header of the Composer Widget tree window to traverse the tree.

**Editor > Hidden Property for Layers**

Setting *Editor > Hidden* hides the layer and all its children from the Graphics Composer Screen Designer but does not affect how the layer and its children are displayed when the application is running. This can be useful when designing complex screens with overlapping layers.

**Alpha Blending Property for Layers**

Enabling Alpha Blending allows you to control the transparency of a layer and all its children. You can experiment with Alpha Blending in the Aria Coffee Maker demonstration. Load the project, launch MHC, and then start the Graphics Composer Screen Designer. There are three layers (Layer0, Layer1, Layer2) in this demonstration. Layer1 (the drag panel on the right) and Layer2 (the drag panel on the left) have Alpha Blending enabled with Alpha Amount = 225. Setting the Alpha Amount to 255 is the same as disabling Alpha Blending (255 = no transparency). Setting the...
Alpha Amount to 0 makes the layer invisible (0 = full transparency, i.e., invisible).

The following figure shows the main screen with Alpha Blending = 225.

The following figure shows the main screen with Layer 2's Alpha Blending = 255.

Double Buffering for Layers

Graphics double buffering for the LCC driver is enabled in the Display Manager's Display Setting screen when the application is changed to use external memory instead of internal. Click **Configure** to bring up the LCC Driver Configuration Settings Window.
Configure the memory according to whether double buffering is to be enabled for the display's layer or layers.
Increasing the Buffer Count of a layer from 1 to 2 enables double buffering for the layer and all its child widgets. To prevent tearing on the display when switching from one buffer to the other, VSync Enabled should also be selected.

**Screens Panel**

Application screens are managed using the Screens Panel.

**Description**

The Screens panel tab manages all the application’s screens, as shown in the following figure.
Note: These screens are examples from the Aria Showcase demonstration project.

The underlined screen name identifies the primary screen (in this case, SplashScreen.) The bold screen name identifies the currently active screen in the Graphics Composer Screen Designer window (in this case MainMenu.) The blue background identifies the selected screen (i.e., the screen that is manipulated by the tool icons), in this case FirstScreen.

Window Toolbar

The window’s tools icons support:

1. Create New Screen – Create a new screen. You will be prompted for the name of the new screen, which will appear at the bottom of the Screens list.
2. Delete Screen – Delete the selected screen. This removes the selected screen from the application.
3. Set as Primary Screen – Sets the selected screen as the default screen displayed by the application at boot-up.
4. Make Screen Active – This selected screen is displayed in the Screen Designer panel. You can also select the active screen by clicking on the screen’s tab at the bottom of the Screen Designer panel.
5. Move Screen Up in Order – Moves the selected screen up in the list of screens, which is useful in organizing a large list of screens, but has no other significance.
6. Move Screen Down in Order – Moves the selected screen down in the list of screens. Useful in organizing a large list of screens, but has no other significance.

Window Columns

The Generate check box is used in selecting those screens that will be included in the application when MPLAB Harmony Configurator (MHC) generates/regenerates the application. (This, along with the Enabled check box for languages, allows customization of the application’s build to support different end uses from the same project.) The Visible check box can be cleared to hide a screen from the sub-tabs located at the bottom of the Screen Designer. The View column provides a mouse-over preview of the screen.

Schemes Panel

Application color schemes are managed using the Schemes Panel.
Description

Color schemes for the application’s graphics are managed using the Schemes sub-tab.

Editing a Scheme

To edit an existing scheme, select the scheme from the list and click Edit.

The Scheme Editor dialog appears, which allows you to change the colors associated with this display scheme.

Scheme Editor

The Scheme Editor window supports editing the individual colors of a color scheme. Clicking the ellipsis (…) opens the Color Picker window.
**Color Picker**

The Color Picker window allows the user to easily select a color by providing a color wheel, brightness gauge, and some common predefined color choices. The user can change the individual color values or input a number in Hexadecimal format. The end result is displayed in the top right corner.
Options

Provides information on the defeatured Options window.

Description

In v2.03b, MPLAB Harmony Graphics Composer user interface provided a third window along with Screens and Schemes, named **Options**. Beginning with v2.04b of MPLAB Harmony, these options are now located within the *File > Settings* menu (see Menus for details).

Widget Tool Box Panel

The Widget Tool Box panel is the interface by which users add widgets into the screen representation.

Description

All the available graphics widgets are shown in the Widget Tool Box:

MPLAB Harmony Graphics Composer provides automatic code optimization by keeping track of the widgets that are currently being used. When MHC generates or regenerates the application, only the Graphics Library code necessary for your design is included in the project.

There are two primary methods for creating new widget objects: clicking and dragging. To add a new layer to a screen use the Screens sub-tab.

Click Method

The following actions can be performed by using the Click method:

- Clicking an item selects it as active. Users can then move the cursor into the screen window and view a representation of the object about to be added.
- Left-clicking confirms the placement of the new object
- Right-clicking aborts object creation
- Clicking the active item again deactivates it
**Drag Method**

Dragging and dropping a tool item into the Screen Designer Window creates a new instance of an object. When dragging a tool item, releasing the cursor outside of the Screen Designer Window cancels the drag operation.

---

**Widget List**

The Graphics Composer Tool Box is the interface by which users add widgets into the screen representation.

---

**Click Method**

The following actions can be performed by using the Click method:

- Clicking an item selects it as active. Users can then move the cursor into the screen window and view a representation of the object about to be added.
- Left-clicking confirms the placement of the new object
- Right-clicking aborts object creation
- Clicking the active item again deactivates it.

---

**Drag Method**

Dragging and dropping a tool item into the Screen Designer Window creates a new instance of an object. When dragging a tool item, releasing the cursor outside of the Screen Designer Window cancels the drag operation.

---

**Automatic Code Optimization**

MPLAB Harmony Graphics Composer keeps track of the types of widgets that are used and updates the MHC Tree constantly to ensure that only the Graphics Library code necessary for your design is included in the project.

---

**Widgets**

Widgets can be configured by using the Properties Editor on the right side of the MHGC interface. Each widget has multiple properties to manage their appearance as well as their functioning. Most properties related to appearance are common between widgets, though some widgets require specific property entries.

- **Button** - A binary On and Off control with events generation for Press and Release state.
- **Check Box** - A selection box with Checked and Unchecked states, and associated events.
- **Circle** - A graphical object in the shape of a circle.
- **Draw Surface** - A container with a callback from its paint loop. a draw surface lets the application have a chance to make draw calls directly to the HAL during LibAria's paint loop.
- **Gradient** - A draw window that can be associated with a gradient color scheme. This allows for color variation on the window.
- **Group Box** - A container with a border and a text title. With respect to functionality, a group box is similar to a window.
- **Image Sequence** - A special widget that allows image display on screen to be scheduled and sequenced. You can select the images to be displayed, the order for display, and the durations.
Image - Allows an image to be displayed on screen. The size and shape of the widget decides the visible part of the image, as scaling is not enabled for images at this time.

Key Pad - A key entry widget that can can be designed for the number of entries divided as specified number of rows and column entries. The widget has a key click event that can be customized.

Label - A text display widget. This does not have any input at runtime capability. A Text Field widget serves that purpose.

Line - A graphical object in the shape of a line.

List Wheel - Allows multiple radial selections that were usually touch-based selections and browsing.

List - Allows making lists of text and image items. The list contents, number of items, and the sequence can be managed through a List Configuration dialog box in the Properties box.

Panel - A container widget that is a simpler alternative to DrawSurface as it does not have the DrawSurface callback feature.

Progress Bar - Displays the progress pointer for an event being monitored through the "Value Changed" event in the Properties Editor.

Radio Button - A set of button widgets that are selected out of the group one at a time. The group is specified by the Group property in the Properties Editor.

Note: The radio buttons in the same group must have the same group number specified in their properties.

Rectangle - A graphical object in the shape of a rectangle.

Scroll Bar - Intended to be used with another relevant widget such as the List Wheel to scroll up and down. It has a callback each time the value is changed. The callback allows users to trigger actions to be handled on the scroll value change event.

Slider - Can change values with an external input such as touch. Event callbacks on value change are also available through the Properties Editor.

Text Field - Text input can be accepted into the text field from an external input or from a widget such as keypad. Event 'Text Changed' in the Properties Editor is used for accepting the input.

Touch Test - Allows tracking of touch inputs. Each new touch input is added to the list of displayed touch coordinates. The input is accepted through the 'Point Added' event callback in the Properties Editor.

Window - A container widget similar to the Panel but has the customizable title bar.

Properties Editor Panel

The properties for all layers and widgets are managed using this panel.

Description

The Properties Editor displays options for the currently-selected object (layer or widget), or the options for the active screen if no objects are selected. To edit an option: left-click the value in the right column and then change the value. Some values have an ellipsis that will provide additional options. In the previous case, the ellipsis button will display the Color Picker dialog.

Some properties, like the screen width and height, are locked and cannot be edited. Other properties offer check boxes and combo-type drop-down box choices. Some properties are grouped together like the Position and Size entries. Individual values of the group can be edited by expanding the group using the plus symbol. For example, the following figure shows properties for a Button Widget.

A new support feature is the ? icon to the right of the Scheme pull-down, which brings up an “Scheme Helper” for the widget showing how it is colored when using a Bevel border. For a more complete description of widget coloring, see Widget Colors.
Object Properties

Provides information on widget, layer, and screen properties.

Description

Object Properties and Event Actions

Each widget has a structured tree of properties, visible under the MPLAB Harmony Configurator window on the right of the standard window setup within MPLAB X IDE. Most widget properties have a Related Event action that can be use in an event or macro to change or set a property from the application.

Each widget has 3-4 property sets:

**Editor** – Controls the behavior of layers and widgets under the MPLAB Harmony Graphics Composer Suite Editor.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locked</td>
<td>Boolean</td>
<td>Locks the object (widget), preventing changes by the designer. Only affects the object (widget) in the editor.</td>
<td>N/A</td>
</tr>
<tr>
<td>Hidden</td>
<td>Boolean</td>
<td>Hides the widget and its children in the designer window. Only affects the appearance of the widget in the editor.</td>
<td>N/A</td>
</tr>
<tr>
<td>Active</td>
<td>Boolean</td>
<td>For layers only. Sets the layer as active. Any objects (widgets) added to the screen will be added to this layer.</td>
<td>N/A</td>
</tr>
<tr>
<td>Locked to Screen Size</td>
<td>Boolean</td>
<td>For layers only. Locks the layer size to the size of the display's screen.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Widget** – Controls the behavior of screens, layers, and widgets on the display.
<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>String</td>
<td>Editable name for each object. By default, widgets are named NameWidget1, ...NameWidgetN. For example: ButtonWidget1, ButtonWidget2, ...</td>
<td>N/A</td>
</tr>
<tr>
<td>Position</td>
<td>[X,Y] Pair of Integers</td>
<td>Location on the layer of the upper left corner of the widget or the location on the display of the upper left corner of the layer. Measured in display pixels. X is measured from left-to-right and Y is measured from up-to-down from the upper left corner of the parent object (typically a Layer or Panel).</td>
<td>Adjust Position, Set X Position, Set Y Position</td>
</tr>
<tr>
<td>Size</td>
<td>[X,Y] Pair of Integers</td>
<td>X: Width, Y: Height of object, in display pixels.</td>
<td>Adjust Size, Set Size, Set Width, Set Height</td>
</tr>
<tr>
<td>Enabled</td>
<td>Boolean</td>
<td>Is the object enabled? Disabled objects are not built into the display's firmware.</td>
<td>Set Enabled</td>
</tr>
<tr>
<td>Visible</td>
<td>Boolean</td>
<td>Is the object visible by default? Object visibility can be manipulated in firmware using laWidget_GetVisible and laWidget_SetVisible.</td>
<td>Set Visible</td>
</tr>
<tr>
<td>Border</td>
<td>Widget Border</td>
<td>Choices are: { None</td>
<td>Line</td>
</tr>
<tr>
<td>Margin</td>
<td>Integer</td>
<td>Four integers ([Left,Top,Right,Bottom]) defining the widget's margins on the display, in display pixels.</td>
<td>Set Margins</td>
</tr>
<tr>
<td>Scheme</td>
<td></td>
<td>Color scheme assigned to the layer or widget. Blank implies the default color scheme.</td>
<td>Set Scheme</td>
</tr>
<tr>
<td>Background Type</td>
<td></td>
<td>Sets the background of the layer or widget. Choices are { None</td>
<td>Fill</td>
</tr>
<tr>
<td>Alpha Blending</td>
<td>Boolean</td>
<td>Is alpha blending enabled for this layer or widget and all of its children? If enabled, specify the amount of alpha blending as an 8-bit integer. Zero makes the object invisible, whereas 255 makes the background invisible.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Widget Advanced** – Advanced control of layers and widgets

<table>
<thead>
<tr>
<th>Optimization Sub-Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw Once</td>
<td>Boolean</td>
<td>Indicates that the widget should draw once per screen Show Event. All other attempts to invalidate or paint the widget will be rejected.</td>
<td>N/A</td>
</tr>
<tr>
<td>Force Opaque</td>
<td>Boolean</td>
<td>Provides a hint to the renderer that the entire area for this widget is opaque. Useful for widgets that may use something like an opaque image to fill the entire widget rectangle despite having fill mode set to None. This can help reduce unnecessary drawing.</td>
<td>N/A</td>
</tr>
<tr>
<td>Local Redraw</td>
<td>Boolean</td>
<td>Provides a “hint” to the widget’s renderer that the widget is responsible for removing old pixel data. This can avoid unnecessary redrawing.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Important!**

Use Local Redraw only if you know what you’re doing!

**Widget Name** (e.g., Button Check Box, Circle, etc.) – Optional properties tied to each widget. See Dedicated Widget Properties and Event Actions.

**Events** – Associates widget events with event call-backs. For example, you can enable and specify a button pressed event and button release event for the Button widget.

For each event you specify:
- Enabled/Disabled Check box – To enable or disable (default) the event.
- Event Callback – Selected from the Event Editor Action List.
There are additional Event actions that do not correspond to any specific property:

- Set Parent – Set the parent of the object, including no parent.

**Dedicated Widget Properties and Event Actions**

**Button**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggleable</td>
<td>Boolean</td>
<td>Is button toggle enabled?</td>
<td>Set Toggleable</td>
</tr>
<tr>
<td>Pressed</td>
<td>Boolean</td>
<td>If Toggleable is enabled, provide default state of the button. This can be used to see the colors of an asserted button.</td>
<td>Set Press State</td>
</tr>
<tr>
<td>Text String</td>
<td></td>
<td>Select widget’s text string from the Select String Dialog.</td>
<td>Set Text</td>
</tr>
<tr>
<td>Alignment:</td>
<td></td>
<td>Text string alignment within the button object. Horizontal alignment. Choices are: { Left</td>
<td>Center</td>
</tr>
<tr>
<td>Pressed Image</td>
<td></td>
<td>Select image used for pressed state. Default: no image.</td>
<td>Set Pressed Image</td>
</tr>
<tr>
<td>Released Image</td>
<td></td>
<td>Select image used for pressed state. Default: no image.</td>
<td>Set Released Image</td>
</tr>
<tr>
<td>Image Position</td>
<td></td>
<td>Position of image relative to button text. Choices are: { LeftOf</td>
<td>Above</td>
</tr>
<tr>
<td>Pressed Offset</td>
<td>Integer</td>
<td>Offset of button contents when pressed. In Pixels. The X and Y position of the button contents is offset by this amount.</td>
<td>Set Pressed Offset</td>
</tr>
</tbody>
</table>

**Check Box**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text String</td>
<td></td>
<td>Select widget’s text string from the Select String Dialog.</td>
<td>Set Text</td>
</tr>
<tr>
<td>Alignment:</td>
<td></td>
<td>Text string alignment within the button object. Horizontal alignment. Choices are: { Left</td>
<td>Center</td>
</tr>
<tr>
<td>Checked</td>
<td>Boolean</td>
<td>Default state of the check box.</td>
<td>Set Check State</td>
</tr>
<tr>
<td>Unchecked Image</td>
<td></td>
<td>Select image used for widget’s unchecked state. Default: no image.</td>
<td>Set Unchecked Image</td>
</tr>
<tr>
<td>Checked Image</td>
<td></td>
<td>Select image used for the widget’s checked state. Default: no image.</td>
<td>Set Checked Image</td>
</tr>
<tr>
<td>Image Position</td>
<td></td>
<td>Position of image relative to check box text. Choices are: { LeftOf</td>
<td>Above</td>
</tr>
<tr>
<td>Image Margin</td>
<td>Integer</td>
<td>Space between image and text. In Pixels.</td>
<td>Set Image Margin</td>
</tr>
</tbody>
</table>

**Circle**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Integer</td>
<td>X offset of circle’s center, from widget's upper left hand corner, in pixels.</td>
<td>N/A</td>
</tr>
<tr>
<td>Y</td>
<td>Integer</td>
<td>Y offset of circle’s center, from widget’s upper left hand corner, in pixels.</td>
<td>N/A</td>
</tr>
<tr>
<td>Radius</td>
<td>Integer</td>
<td>Circle’s radius, in pixels.</td>
<td>Set Radius</td>
</tr>
</tbody>
</table>

**Draw Surface** – No additional properties.

**Gradient**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direction</td>
<td></td>
<td>Gradient draw direction. Choices are: { Right</td>
<td>Down</td>
</tr>
</tbody>
</table>

**Group Box**
### Text String
Select widget’s text string from the Select String Dialog.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text String</td>
<td></td>
<td></td>
<td>Set Text</td>
</tr>
<tr>
<td>Alignment</td>
<td></td>
<td>Text string alignment within the widget. Choices are: { Left</td>
<td>Center</td>
</tr>
</tbody>
</table>

### Image Sequence
Specify image sequence by using the Image Sequence Configuration Dialog window.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence Configuration Dialog</td>
<td></td>
<td></td>
<td>Set Entry Image, Set Entry Horizontal Alignment, Set Entry Vertical Alignment, Set Entry Duration, Set Image Count</td>
</tr>
<tr>
<td>Starting Image</td>
<td>Integer</td>
<td>Selects the first image to be shown.</td>
<td>Set Active Image</td>
</tr>
<tr>
<td>Play By Default</td>
<td>Boolean</td>
<td>Will image sequence play automatically?</td>
<td>N/A</td>
</tr>
<tr>
<td>Repeat</td>
<td>Boolean</td>
<td>Should the image sequence repeat?</td>
<td>Set Repeat, Additional related event actions: Show Next, Start Playing, Stop Playing.</td>
</tr>
</tbody>
</table>

### Image Widget
Select image used. 

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td></td>
<td>Select image used.</td>
<td>Set Image</td>
</tr>
<tr>
<td>Alignment:</td>
<td></td>
<td>Image alignment within the image object.</td>
<td></td>
</tr>
<tr>
<td>Horizontal</td>
<td></td>
<td>Horizontal alignment. Choices are: { Left</td>
<td>Center</td>
</tr>
<tr>
<td>Vertical</td>
<td></td>
<td>Vertical alignment. Choices are: { Top</td>
<td>Middle</td>
</tr>
</tbody>
</table>

### Key Pad
(No Event Actions are currently available for this widget.)

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Count</td>
<td>Integer</td>
<td>Number of key rows.</td>
<td>None</td>
</tr>
<tr>
<td>Column Count</td>
<td>Integer</td>
<td>Number of key columns.</td>
<td>None</td>
</tr>
<tr>
<td>Key Pad Configuration Dialog</td>
<td>(see Description)</td>
<td>This dialog window has the following:</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Width – Integer. Width of each key, in pixels.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Height – Integer. Height of each key, in pixels.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rows – Integer. Number of key rows. A duplicate of Row Count.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Columns – Integer. Number of key columns. A duplicate of Column Count.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selecting one of the keys on the key pad diagram displays the Cell Properties for that key:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Enabled – Boolean. Disabled cells (keys) are made invisible.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Text String – Select key’s text string from the Select String Dialog.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Pressed Image – Select image used for pressed state.</td>
<td>Default: no image</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Released Image – Select image used for released state.</td>
<td>Default: no image</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Image Position – Position of image relative to key text;</td>
<td>Choice are: { LeftOf</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Image Margin – Integer. Space between image and text. In Pixels.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Draw Background – Boolean. Controls whether the key should fill its</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>background rectangle.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Editor Action – Select the generic editor action that fires when the key is</td>
<td>Choice are: { None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>clicked. Choices are: { None</td>
<td>Accept</td>
</tr>
</tbody>
</table>

### Label
<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text String</td>
<td></td>
<td>Select widget’s text string from the Select String Dialog.</td>
<td>Set Text</td>
</tr>
<tr>
<td>Alignment:</td>
<td></td>
<td>Text string alignment within the widget.</td>
<td></td>
</tr>
<tr>
<td>• Horizontal</td>
<td></td>
<td>Horizontal alignment. Choices are: { Left</td>
<td>Center</td>
</tr>
<tr>
<td>• Vertical</td>
<td></td>
<td>Vertical alignment. Choices are: { Top</td>
<td>Middle</td>
</tr>
</tbody>
</table>

**Line**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start X</td>
<td>Integer</td>
<td>X start of line, in pixels, from upper left hand corner of the widget.</td>
<td>Set Start Point Position</td>
</tr>
<tr>
<td>Start Y</td>
<td>Integer</td>
<td>Y start of line, in pixels, from upper left hand corner of the widget.</td>
<td></td>
</tr>
<tr>
<td>End X</td>
<td>Integer</td>
<td>X end of line, in pixels, from upper left hand corner of the widget.</td>
<td>Set End Point Position.</td>
</tr>
<tr>
<td>End Y</td>
<td>Integer</td>
<td>Y end of line, in pixels, from upper left hand corner of the widget.</td>
<td></td>
</tr>
</tbody>
</table>

**List**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection Mode</td>
<td></td>
<td>Select list selection mode. Choices are: {Single</td>
<td>Multiple</td>
</tr>
<tr>
<td>Allow Empty Selection</td>
<td>Boolean</td>
<td>Is a list selection allowed to be empty?</td>
<td>Set Allow Empty Selection</td>
</tr>
<tr>
<td>Alignment</td>
<td></td>
<td>Horizontal text alignment. Choices are: { Left</td>
<td>Center</td>
</tr>
<tr>
<td>Icon Position</td>
<td></td>
<td>Position of list icons relative to list text. Choices are: { LeftOf</td>
<td>RightOf }.</td>
</tr>
<tr>
<td>Icon Margin</td>
<td></td>
<td>Space between icon and text, in pixels.</td>
<td>Set Icon Margin</td>
</tr>
<tr>
<td>List Configuration Dialog</td>
<td></td>
<td>Defines the string and icon image for each entry in the list.</td>
<td>Set Item Icon, Set Item Icon (actually sets item text). Additional Related Event Actions: Deselect All Items, Insert Item, Remove All Items, Remove Item, Select All Items, Set Item Selected, Toggle Item Selected(ed).</td>
</tr>
</tbody>
</table>

**List Wheel**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alignment</td>
<td></td>
<td>Sets horizontal text alignment. Choices are: { Left</td>
<td>Center</td>
</tr>
<tr>
<td>Icon Position</td>
<td></td>
<td>Position of icons relative to text. Choices are: { LeftOf</td>
<td>RightOf }.</td>
</tr>
<tr>
<td>Icon Margin</td>
<td>Integer</td>
<td>Sets the space between icon and text. In pixels.</td>
<td>Set Icon Margin</td>
</tr>
<tr>
<td>Selected Index</td>
<td>Integer</td>
<td>Selects the default list item.</td>
<td>Set Selected Index</td>
</tr>
<tr>
<td>List Configuration Dialog</td>
<td></td>
<td>Defines the image/text for each entry in the list.</td>
<td>Set Item Icon, Set Item Icon (actually sets item text) Additional Related Event Actions: Append Item, Insert Item, Remove All Items, Remove Item, Select Next Item, Select Previous Item.</td>
</tr>
</tbody>
</table>

**Panel** – No additional properties.

**Progress Bar**
<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direction</td>
<td></td>
<td>Direction of progress bar. Choices are: { Right</td>
<td>Down</td>
</tr>
<tr>
<td>Value</td>
<td></td>
<td>Default value of the progress bar. The primitives laProgressBarWidget_GetValue and laProgressBarWidget_GetValue can be used to manipulate the widget’s value during run time.</td>
<td>Set Value</td>
</tr>
</tbody>
</table>

**Radio Button**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text String</td>
<td></td>
<td>Select widget’s text string from the Select String Dialog.</td>
<td>Set Text</td>
</tr>
<tr>
<td>Alignment:</td>
<td></td>
<td>Text string alignment within the widget. Horizontal alignment. Choices are: { Left</td>
<td>Center</td>
</tr>
<tr>
<td>Group</td>
<td>Integer</td>
<td>Radio Button Group Number. Default is -1, indicating no group. Only one radio button in a group can have a default selected value of On. All others in the group are Off</td>
<td>N/A</td>
</tr>
<tr>
<td>Selected</td>
<td>Boolean</td>
<td>If selected, the button has a default value of On. All other buttons in the group have a Selected value of Off.</td>
<td>Select</td>
</tr>
<tr>
<td>Selected Image</td>
<td></td>
<td>Select image used for selected state. Default: no image.</td>
<td>Set Selected Image</td>
</tr>
<tr>
<td>Unselected Image</td>
<td></td>
<td>Select image used for unselected state. Default: no image.</td>
<td>Set Unselected Image</td>
</tr>
<tr>
<td>Image Position</td>
<td></td>
<td>Position of image relative to widget text. Choices are: { LeftOf</td>
<td>Above</td>
</tr>
<tr>
<td>Image Margin</td>
<td></td>
<td>Space between radio button image and text, in pixels.</td>
<td>Set Image Margin</td>
</tr>
</tbody>
</table>

**Rectangle**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness</td>
<td>Integer</td>
<td>Line thickness in pixels.</td>
<td>Set Thickness</td>
</tr>
</tbody>
</table>

**Scroll Bar**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
<td></td>
<td>Scroll bar orientation. Choices are: { Vertical</td>
<td>Horizontal }.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Integer</td>
<td>Maximum scroll value (minimum = 0.)</td>
<td>Set Maximum Value</td>
</tr>
<tr>
<td>Extent</td>
<td>Integer</td>
<td>Length of scroll bar slider, re scroll bar maximum value. Indicates the number of lines or size of window visible at each scroll setting.</td>
<td>Set Extent</td>
</tr>
<tr>
<td>Value</td>
<td>Integer</td>
<td>Initial scroll bar value.</td>
<td>Set Value, Set Value Percentage</td>
</tr>
<tr>
<td>Step Size</td>
<td>Integer</td>
<td>Step size value of scroll bar arrow buttons. ( Min = 1, Max = 9999 ).</td>
<td>Set Step Size, Additional Related Event Actions: Step Backward, Step Forward</td>
</tr>
</tbody>
</table>

**Slider**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
<td></td>
<td>Orientation of the slider. Choices are: { Vertical</td>
<td>Horizontal }.</td>
</tr>
<tr>
<td>Minimum</td>
<td></td>
<td>Minimum slider value.</td>
<td>Set Minimum Value</td>
</tr>
<tr>
<td>Maximum</td>
<td></td>
<td>Maximum slider value.</td>
<td>Set Maximum Value</td>
</tr>
<tr>
<td>Value</td>
<td></td>
<td>Initial slider value.</td>
<td>Set Value, Set Value Percentage</td>
</tr>
<tr>
<td>Grip Size</td>
<td></td>
<td>Grip size of slider, from 10 to 9999, in pixels.</td>
<td>Set Grip Size, Additional Related Event Actions: Step</td>
</tr>
</tbody>
</table>
### Text Field

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text String</td>
<td></td>
<td>Select widget’s text string from the Select String Dialog.</td>
<td>Clear Text followed by Append Text</td>
</tr>
<tr>
<td>Alignment</td>
<td></td>
<td>Horizontal alignment. Choices are: { Left</td>
<td>Center</td>
</tr>
<tr>
<td>Cursor Enable</td>
<td>Boolean</td>
<td>Show blinking cursor while editing.</td>
<td>Set Cursor Enabled</td>
</tr>
<tr>
<td>Cursor Delay</td>
<td></td>
<td>Cursor delay in milliseconds. From 1 to 999,999.</td>
<td>Set Cursor Delay Additional Related Event Actions: Accept Text, Append Text, Backspace, Clear Text, Start Editing</td>
</tr>
</tbody>
</table>

**Touch Test** – No dedicated properties.

### Window

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title String</td>
<td></td>
<td>Select widget’s title string from the Select String Dialog.</td>
<td>Set Title</td>
</tr>
<tr>
<td>Icon Image</td>
<td></td>
<td>Select image used. Default: no image.</td>
<td>Set Icon</td>
</tr>
<tr>
<td>Image Margin</td>
<td>Integer</td>
<td>Space between icon and title, in pixels.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Layer Properties and Event Actions

The property list for a graphic layer is close in look and feel to that of a widget. Each Layer has three property sets: Editor (see above), Widget (see above), and Layer (see below).

#### Layer Properties

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transparency Enabled</td>
<td>Boolean</td>
<td>Automatically mask out pixels of with a specified color.</td>
<td>N/A</td>
</tr>
<tr>
<td>Mask Color</td>
<td>Integer</td>
<td>Red/Green/Blue or Red/Green/Blue/Alpha color value</td>
<td>N/A</td>
</tr>
<tr>
<td>All Input Passthrough</td>
<td>Boolean</td>
<td>Allow input events to pass through this layer to layers behind it.</td>
<td>N/A</td>
</tr>
<tr>
<td>VSync Enabled</td>
<td>Boolean</td>
<td>Layers should swap only during vertical syncs.</td>
<td>N/A</td>
</tr>
<tr>
<td>Buffer Count</td>
<td>Integer</td>
<td>Integer number of frame buffers associated with this layer, either 1 or 2.</td>
<td>N/A</td>
</tr>
<tr>
<td>Buffer N</td>
<td></td>
<td>For each buffer (N= 1 or 2) you specify:</td>
<td></td>
</tr>
<tr>
<td>Allocation Method</td>
<td></td>
<td>Buffer allocation method. Choices are: { Auto</td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Auto – Automatically allocate frame buffer space</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Address – Specify a memory address</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Variable Name – Use variable name as buffer location</td>
<td></td>
</tr>
<tr>
<td>Memory Address</td>
<td></td>
<td>If Address is the allocation method, specify the raw (physical) memory address</td>
<td>N/A</td>
</tr>
<tr>
<td>Variable Name</td>
<td>String</td>
<td>If Variable name is the allocation method, specify the variable name as a string value.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Screen Properties and Events

The property list for a screen shares the Name and Size properties with Layers and Widgets but has these unique properties.

#### Screen Properties

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Description</th>
<th>Related Event Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
<td></td>
<td>Display orientation: 0, 90, 180, 270 Degrees. This can also be set using the Display Manager.</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Boolean</td>
<td>Enables screen mirroring.</td>
<td>N/A</td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
<td>--------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>Layer Swap Sync</td>
<td>Boolean</td>
<td>Enables that all layer buffer swapping happen at the same time, delaying lower layers until higher layers are finished drawing as well. For example, assume you make changes to layer 0 and layer 1 and you want to see those changes show up on the screen at the same time. Without this option you’d see layer 0’s changes as soon as it finishes when layer 1 has not yet started drawing. This option will hold layer 0’s swap operation until layer 1 finishes as well.</td>
<td>N/A</td>
</tr>
<tr>
<td>Note: Currently, this property is only supported by the CLCD Graphics Controller Driver and is ignored by all other drivers.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Persistent</td>
<td>Boolean</td>
<td>Indicates that the screen should not free its widgets and memory when it is hidden. This results in faster load times and persistent data, but at the cost of higher memory consumption.</td>
<td>N/A</td>
</tr>
<tr>
<td>Export</td>
<td>Boolean</td>
<td>Includes this screen the application build. This can also be set using the Screens panel.</td>
<td>N/A</td>
</tr>
<tr>
<td>Primary</td>
<td>Boolean</td>
<td>Sets this screen as the primary screen. The primary screen is the first screen displayed when the application starts. This can also be done using the Screens Panel Generate check box.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Graphics Composer Asset Management**

The Asset menu supports managing all graphical assets (memory, images, languages, fonts, strings, and binary data).

**Memory Configuration**

Provides information on configuring memory locations.

**Description**

The Memory Locations window is launched from the Graphics Composer’s Asset menu. Selecting Memory Locations this brings up a window with three sub-tabs (in this example, the Aria Showcase demonstration is referenced):
The window’s tools icons support:

1. **Add New Memory Location** – This supports multiple external memory resources.
2. **Delete Selected Memory Location** – Removes a previously defined memory location.
3. **Rename Selected Memory Location** – Renames a previously defined memory location.
4. **Configure External Media Application Callback** – This allows definition of media callbacks, which must be provided in the project.

**Tool Icons:**
- 1: Add New Memory Location
- 2: Delete Selected Memory Location
- 3: Rename Selected Memory Location
- 4: Configure External Media Application Callback
- 5: Show Values as Percent
5. **Show Values as Percent** – Memory utilization on the bar graph can be in bytes or as a percent of the total internal flash memory assigned to support asset storage. (That memory allocation is set using the Configuration sub-tab.)

The APIs for the external media callback functions are as follows:

```c
GFX_Result app_externalMediaOpen(GFXU_AssetHeader* asset);
GFX_Result app_externalMediaRead(GFXU_ExternalAssetReader* reader,
                                  GFXU_AssetHeader* asset,
                                  void* address,
                                  uint32_t readSize,
                                  uint8_t* destBuffer,
                                  GFXU_MediaReadRequestCallback_FnPtr cb);
void app_externalMediaClose(GFXU_AssetHeader* asset);
```

The graphics demonstration project, `aria_external_resources`, provides an example of how to write these callbacks. This demonstration supports three types of external memory: SQI External Memory, USB Binary, and USB with File System. Examples of these callbacks are found in the project's `app.c` file. The Aria demonstration projects Aria External Resources and Aria Flash provide more details on how to use external memory to store graphics assets.

### Sub-tabs

There are three sub-tabs to this window.

#### Summary Sub-tab

This sub-tab summarizes program flash allocations for images, strings, and fonts.
The memory allocation shown for “Font Glyphs” measure the space that holds all the font glyphs used by the application, either by static strings or by glyph ranges defined in support of dynamic strings. Strings are defined by arrays of pointers to glyphs, so string memory usage measures the size of these arrays, not the actual font glyphs used. (“Glyph” is defined here.)

Note: The word “glyph” comes from the Greek for “carving”, as seen in the word hieroglyph – Greek for “sacred writing”. In modern usage, a glyph is an elemental or atomic symbol representing a readable character for purposes of communicating through writing.

Configuration Sub-tab
This sub-tab specifies the intended allocation of internal (program) flash memory to graphics assets (Total Size). (The default value is 1024 bytes.) It also names the graphics assets file name (here it will be gfx_assets.c). The allocation of flash is only used to scale the Total/Used/Available bar graph at the top of the display. Under sizing or oversizing this amount does not affect how the application is built.

If your device has 1024 Kbytes (1048576 bytes) of flash, you can assign 40% to asset storage and 60% to code. In that case the “Total Size” in the above sub-tab would be set to 419430 (= 40% of 1048576).

The Calculator button can assist you in allocating internal flash. Click on it and then set the device flash capacity. Then you can apply an adjustment to that value to assign that memory to asset storage.

Example:
If the device has 2 Mbytes of internal Flash, click 2MB.
Then, to assign 75% of the 2 Mbytes to asset storage, click -25% to reduce the 2 MB by 25%, leaving 75%, and then click OK to finish. This will then assign 1,536,000 bytes to asset storage.

Internal (program) Flash is shared between the application's code and asset storage. If the application code and graphics assets (fonts, strings, images) won't fit into the available flash memory then the linker will be unable to build the application and an error will be generated in MPLAB X IDE.

The Output File Name must be compatible with the operating system hosting MPLAB X IDE. In most cases the default name (gfx_asset.c) will suffice, but this is provided for additional flexibility in building the application.

Optimization Sub-tab

The Optimization sub-tab for the Aria Quickstart demonstration is shown in the following figure.
The **Size** column shows the bytes allocated for storage in internal flash for the images, fonts, and binaries of the application.

The **References** column shows the number of known references for these assets by the application's widgets. A references count of zero suggests that the asset is not used by the application, but it could also mean that the asset is only used in real-time when it is dynamically assigned to a widget by the application.

The window's tools icons support:

1. **Edit Selected Asset** – This brings up the edit dialog for the image, font, or binary chosen
2. **Delete Selected Assets** – Removes the selected assets
3. **Move Selected Assets** – Move assets from one location to another. This is useful for moving assets to/from internal memory from/to external memory.
4. **Show Only Images** – Show only image assets
5. **Show Only Fonts** – Show only font assets
6. **Show Only Binaries** – Show only binary assets

### Image Assets

Provides information on the Image Assets features.

#### Description

The Image Assets window is launched from the Graphics Composer’s Asset menu.

The Image Assets window lets you import images, select different image formats/color modes for each image, select compression methods (for example, RLE) for each image, and displays the memory footprint of each. Images can be imported as a BMP, GIF, JPEG, and PNG (but not TIFF). Images can be stored as Raw (BMP, GIF), JPEG, and PNG.

**Note:** MHGC does not support image motion that can be found in GIF (.gif) files. GIF images are stored in the raw image format, meaning that there is no image header information stored with the image.

When an image is imported into MGHC, the Graphics Asset Converter (GAC) stores the input format and color mode along with any relevant header data. The image’s pixel data is then promoted from its native format into a Java Image using 32 bits/pixel (8 bits for each color, RGB, and 8 bits for Alpha Blending). If the image contains Alpha Blending then this information is stored in the “A” of RGBA, otherwise the “A” is set to maximum opacity. When the application is built each image is stored in the image format and color mode selected. Images displayed in the Screen Designer are converted from Java Image format into the format/color mode selected so that the Screen Designer accurately represents what the application will show when running.

The images are decoded on the fly by the graphics library and rendered on the screen. This provides the designer with considerable flexibility to import using one format and store resources using another format, thus exploring and maximizing the best memory utilization for their application.
and hardware. This supports trading a smaller memory footprint at the cost of additional processing (for static or drawn-once) or reducing processing at the cost of a larger memory footprint (dynamic or drawn many times).

**Note:** The PNG format should only be used for small (64x64 pixels or less) icons needing alpha blending. For larger images, use the JPEG format.

The following figure shows the Image Assets window for the Aria Quickstart demonstration.

---

**Tool Icons:**
1. Add Image From File
2. Replace Existing Image with New Image File
3. Rename Selected Image
4. Create New Virtual Folder
5. Delete Selected Images

**Window Toolbar**

There are five icons on the toolbar below the Images tab:

1. **Add Image Asset** – Brings up “Import Image File” dialog window to select image file to add to the graphics application.
2. **Replace Existing Image with New Image File** – Brings up the same “Import Image File” dialog but instead of creating a new image, the file’s content replaces the currently selected image.
3. **Rename Selected Image** – Renames the selected image.
4. **Create New Virtual Folder** – Creates a new virtual folder, allowing you to organize images in a hierarchy.
5. **Delete Selected Images** – removes the selected images from the application.

Selecting the Add Image Asset or Replace Existing Image icon opens the Import Image File dialog that can be used to select and import an image.

---

After selecting the file and clicking **Open**, the Image Assets window opens.
The size of the memory used for this image based on its color mode, format, compression, and global palette usage is shown by Size (bytes). See Image Format Options below for more details.

The File Name of the original source file is also shown, but may be blank if the image was imported under MPLAB Harmony v2.03b or earlier. The format and color mode of the stored image can be changed to reduce the image's memory footprint. (If using an LCC controller, you can also turn on the Global Palette, replacing each pixel in the image with just an 8 bit LUT index.)

The three internal image formats are:

- **Raw** – binary bit map with no associated header information. GIF and BMP images are imported into this format.
- **PNG** – lossless image format with compression, 24 bits/pixel (RGB_888) or 32 bits/pixel (RGBA_8888). A good choice for line drawings, text, and icons. Only small (64x64) images are currently supported.
- **JPEG (JPG)** – loss compressed format, uses much less storage than the equivalent bit map (raw). Good for photos and realistic images.

The Image Assets window supports resizing, cropping, or resetting an image:

- **Resize** – Brings up a dialog window to change the pixel dimensions of the image. The image is interpolated from the original pixel array into the new pixel array.
- **Crop** – Places a cropping rectangle on the image. Click and drag a rectangle across the image to select the new image. Then click Ok to crop the image.
• **Reset** – Allows undoing of a resize or crop. The original image is always stored in the project, so a Reset is always available to return the image to its original state.

Original images are retained by MHGC by the superset Java Image format. So an image crop will change how the image is stored in the application but not how it is stored in MHGC. Reset will always restore the image back to the original pixels. (Reset is not an “undo”.)

**Example Images**

Example images are available from many sites on the internet. One of the best sites is found at the USC-SIPI Image Database (http://sipi.usc.edu/database/). There are many canonical test images, such as Lena, The Mandrill (Baboon), and other favorites, all in the TIFF format. The TIFF format is not supported by the Graphics Composer, but you can easily convert from TIFF to BMP, GIF, JPEG, or PNG using the export feature found in the GNU Image Manipulation Program (GIMP), which is available for free download at: https://www.gimp.org. GIMP also allows you to change the pixel size of these images, usually 512x512, to something that will fit on the MEB II display (either 256x256 or smaller).

The following figure shows the Graphics Composer Screen Designer for the pic32mz_da_sk_meb2 configuration of the Aria Quick Start project after adding three images.

The following figure shows the Optimization Tab after adding these images.
Selecting the Baboon_GIF image and the Edit Selected Asset icon (✓) opens an Image Assets window, as shown in the following figure.

Because this image had only 253 unique pixel colors (Unique Pixel Count = 253) the Enable Palette option was automatically enabled. This feature, which works on an image by image basis, is separate from enabling a Global Palette. The image is stored using 8 bits of indexing into an image-specific lookup table (LUT). If the image has more than 256 unique colors then the Enable Palette option is not available and is not shown.

**Image Format Options**

**Raw Format Images**

Raw format images have the following options:
Regardless of the Color Mode of the imported image, the stored image can be stored in a different color mode. For example, a JPEG image could be in 24 bits/pixel RGB format but stored in the application using RGB_565 or even RGB_332 to save space. The Project Color Mode (set through the File > Settings menu) is different from the Color Mode of images. This is determined by the capabilities of the projects graphics controller. The graphics library converts images from the stored color mode to the project’s color mode before output.

If the image has 256 or less unique pixel colors an option to Enable Palette is set by default. If the image has more than 256 unique colors this option is not displayed. This replaces the palette pixels with 8-bit indices into the image’s palette look up table (LUT). NOTE: Enabling the Global Palette disables this for all images and all image pixels are replaced by 8-bit indices into the global palette LUT.

The Compression Mode for a raw format image is either None (no compression) or RLE for run-length encoding.

Image masking is a form of cheap blending. For example, given the following image, you may want to show the image without having to match the lime green background. With image masking you can specify that the lime green color as the “mask color”, causing it to be ignored when drawing this image. The rasterizer will simply match a pixel to be drawn with the mask. If they match, the pixel is not rendered.

PNG Format Images

For PNG format images you can change the image format and the image color mode:

JPEG Format Images

For JPEG format images you can change from JPEG format to Raw or PNG:

Once changed from JPEG into another format, the new format will have other options.

Font Assets

Provides information on the Font Assets features.

Description

The Font Assets window is launched from the Graphics Composer’s Asset menu.

Note:

There are three dimensions to text support: Languages, Fonts, and Strings. Language “ID” strings are identified when an application supports more than one language. (In the case of single language support, the language default is provided.) Fonts are imported and organized using the Font Assets window. Strings are defined by a string name, and this name is used by widgets to reference the string. For each string and each language supported the glyphs are defined to spell out the string’s text and the font is chosen for that text.

- Languages are managed within the String Table Configuration window
- Fonts are managed within the Font Assets window (this topic)
- Strings are managed within the String Assets window

The following figure shows the Font Assets window from the Aria Coffee Maker demonstration.
The Size (bytes): for a Font asset shows how much memory is needed to store all the glyphs used by the application from this font. For static strings MHGC determines which glyphs are used by the application’s pre-defined strings and builds these glyphs into the application. For dynamic strings (i.e. strings created during run time) ranges of glyphs are selected by the designer and these ranges are also included in the application by MHGC. The memory needed to store all these glyphs is shown by Size (bytes):.

**Window Toolbar**

There are five icons on the toolbar below the Images tab:

1. **Add Font From File** – Adds a font asset from a file.
2. **Add Installed Font** – Add a font installed on your computer.

3. **Replace Existing Font Data with New Source Font** – Both Add Font From File and Add Installed Font create a new font asset. This icon allows you to update an existing font asset, importing from a file or using a font installed on your computer.

4. **Rename Selected Font** – Renames an existing font asset. In the example above, the Arial font was installed twice, first as a 16 point font and second as a 12 point font. If added to the fonts assets in this order, the 12 point font will have the name Arial_1. This font asset was renamed to Arial_Small using this tool.
5. **Delete Selected Fonts** – Removes selected font assets from the application.

**Sub-tabs**

There are three sub-tabs to this window.

**Style Sub-tab**

The Size (bytes): shown represents the memory needed to store all the font’s glyphs. The application only stores the glyphs that are used by static (build-time) strings and by predefined glyph ranges to support dynamic (run-time) strings.

The choices for Memory Location must be defined before the font can be assigned. Go to the Memory Configuration window to add a new location before using it in this sub-tab.

Each font asset consists of a font, size, and some combination of the (Bold, Italic, Anti-Aliasing) options, including selecting none of these options. If you need bold for one set of strings and italic for another, then you will need two font assets, one with Bold checked and a second with Italic checked. The same applies for font sizes. Each font size requires its own font asset. Thus if you need two sizes of Arial, with plain, bold, and italic for each size, you will need 6 separate assets (6 = 2 Sizes x 3 ).

Glyphs are normally (Anti-Aliasing off) stored as a pixel bit array, with each pixel represented by only one bit. Turning on Anti-Aliasing replaces each pixel bit with an 8-bit gray scale, thereby increasing font storage by a factor of 8!

What if a font is chosen that does not support the character types of the text used for a particular language in the application? How can you test and debug this? There are basically two ways:

- Use an external font viewer to examine if the needed glyphs exist
- Configure, build, and run the application and verify the strings are correctly rendered

If the glyphs are not available they will be rendered as rectangles (□).
Strings Sub-tab

The Bound check box accomplishes the same thing as assigning a font to a text string in the Strings Assets window (Window:Strings menu). Assigning a string to a font means that the font will generate glyphs for that string. This is just another way to accomplish the binding of the string text to font.

This sub-tab is also useful in a complicated graphics design to see how many strings use a particular font. Lightly-used or unused fonts can be eliminated to free up internal Flash memory.

Glyphs Sub-tab

Note: The word “glyph” comes from the Greek for “carving”, as seen in the word hieroglyph – Greek for “sacred writing”. In modern usage a glyph is an elemental or atomic symbol representing a readable character for purposes of communicating via writing.

The Glyph sub-tab is only used when your application supports dynamic strings. For static (build-time) strings MHGC automatically determines which font glyphs are used based on the characters present in all the strings used by the application’s graphics widgets. Only these glyphs are included as part of the application’s font assets. With dynamic (i.e. run-time) strings this is not possible. This sub-tab allows you to specify which range of glyphs will be used by run-time strings. Once glyph ranges are defined, these glyphs are added to the font glyphs used by static strings.

The Create New Custom Import Range icon ( ) allows you to input a new glyph range for the font. Selecting this icon opens the Font Assets window.
String Table Configuration

Provides information on the String Assets features.

Description

The String Table Configuration window is launched from the Graphics Composer’s Asset menu.

**Note:** There are three dimensions to text support: Languages, Fonts, and Strings. Language “ID” strings are identified when an application supports more than one language. (In the case of single language support, the language default is provided.) Fonts are imported and organized using the Font Assets window. Strings are defined by a string name, and this name is used by widgets to reference the string. For each string and each language supported the glyphs are defined to spell out the string’s text and the font is chosen for that text.

- Languages are managed within the String Table Configuration window (this topic)
- Fonts are managed within the Font Assets window
- Strings are managed within the String Assets window

Within this window, the Languages supported by the application are defined and the encoding for all application glyphs selected.

The “ID” string used for each language is merely for ease of use in building the texts to be used. “English”, “American”, or any other string can be used to identify that language, as long as it is understood by the application’s creator when selecting the text to be used for that particular language. Then the application can switch to supporting one of its languages using “ID” strings defined.

Here is an example string asset definition, taken from the Aria Coffee Maker demonstration. This application supports English, French, Italian, and German. The text string “InfoText_Desc9” uses the Arial font, and text for each language is specified within the String Assets window.
Any number of languages can be defined as long as there is memory to store the strings needed.

The following figure shows the String Table Configuration for an application that uses English, Spanish, and Chinese.

The size of all the strings for each language is shown in the Size column. String size represents the memory allocated for glyph indices for all the strings supporting that language. A language can be enabled/disabled via the check box in the Enabled column. Disabling a language removes it from the application build but keeps it in the project.

Window Toolbar

There are three icons on the toolbar:

1. Add New Language – Adds a new language.
2. Set Default Language – Sets the application’s default language. Note, this is different than the abc tool on the Graphics Composer Window toolbar. The abc icon sets the preview language for the Screen Designer panel only. This icon sets the language used by the application after boot-up.
3. Remove Selected Language – Removes language from the application.

Clicking Add New Language opens a new line, allowing you to select and edit the new language’s “ID” string.
Then, for every string defined in the application there will be a line to define the needed text, and to specify the font to be used.

If you don’t provide a value for the new language the string will be output as a null (empty string). If you don’t provide a Font selection then the string will be output as a series of blocks (?).

The Aria User Interface Library primitive, `LIB_EXPORT void laContext_SetStringLanguage(uint32_t id)`, allows the application to switch between languages using the Language ID #defines are specified in the application’s gfx_assets.h file.

**Sub-tabs**

There are two sub-tabs to this window.

**Language Definitions Sub-tab**

This sub-tab shows the languages defined for the application. A Language can be enabled/disabled to include or exclude it from the application’s generation/regeneration under MPLAB Harmony Configurator (MHC). New languages can be added by specifying a text string for the language. With a new language, go to the String Assets window to specify the text and fonts for all defined strings.

**Encoding Sub-tab**

Selecting the Character Encoding Format Selection Dialog icon gives you three choices for how the characters in all strings in the graphics application are encoded:
The default is ASCII. It is typically the most efficient in terms of memory and processing, but it does not support as many glyphs. Chinese text should be encoded in UTF-8 or UTF-16, but Western language text can be encoded in ASCII to save memory. The trade-off between ASCII, UTF-8, and UTF-16 depends on the application. Changing from UTF-8 to UTF-16 will double the size of all strings in the application. This is because the sizes of all glyph indices double in size. (String sizes are the sizes of glyph reference indices, not the size of the particular font glyphs used to write out the string.)

The memory utilization resulting from an encoding choice can be seen in the Summary sub-tab of the Memory Configuration window.

### String Assets

Provides information on the String Assets features.

**Description**

The String Assets window is launched from the Graphics Composer’s Asset menu.

The String Assets window supports managing the strings in the application. Strings are referenced by graphic widgets using an application-wide unique name. This unique name is built into an enumeration that the application’s C code uses. For each language supported text is defined and a font asset selected.

- **Languages** are managed within the String Table Configuration window
- **Fonts** are managed within the Font Assets window
- **Strings** are managed within the String Assets window (this topic)

**Note:** There are three dimensions to text support: Languages, Fonts, and Strings. Language “ID” strings are identified when an application supports more than one language. (In the case of single language support, the language default is provided.) Fonts are imported and organized using the Font Assets window. Strings are defined by a string name, and this name is used by widgets to reference the string. For each string and each language supported the glyphs are defined to spell out the string’s text and the font is chosen for that text.

The following figure shows an example taken from the Aria Coffee Maker demonstration. The string name, InfoText_Desc9, defines a string asset that is used by the application.
The Total Size in Byte: for a string asset represents the memory needed to store the glyph indices for all the text defined for that string asset. Adding more text will increase the number of glyph indices needed thus increasing the size of the string’s memory. Adding another language will do the same, since the number of glyph indices also increases. Changing the font does not increase the size of the string’s memory, but may increase the size of the font chosen if it is a “bigger” font and adds more glyphs to the new font. (By “bigger” we mean a font with more pixels, for example because it is bigger in size, or perhaps because it is anti-aliased and the original font was not.)

Note: The Reference Count shown reflects the number of build-time references to the string. Dynamic uses of a string, such as through macros or events, is not reflected in this number.

Window Toolbar
There are four icons on the toolbar:
1. Add New String – Adds a new string.
2. Rename Selected Item – Allows renaming the string.
3. Create New Virtual Folder – Creates a new virtual folder, allowing you to organize strings in a hierarchy. Here’s an example reorganization of the existing strings. Note the order of virtual folders or items in the list is strictly alphabetical. Virtual folders and string asset organization is merely for the convenience of the developer. Neither has an effect on how the application is built.
4. **Delete Selected Items** – Deletes selected strings from the application.

**Creating New Strings**

To create a new string, click Add New String ( ).

Selecting this icon opens the Add String dialog to name the string. The text chosen for the string name should be acceptable as a C variable.

After entering the new string’s name and click Create, the following String Assets window appears.
In the String Assets window, there will be a line for each of the languages defined for the application. Provide the string text and font for each of the languages. If you don’t provide the text an empty string will be used instead. Not providing a font causes the string to be rendered as a string of boxes ( ⬛ ).

**Binary Assets**

Provides information on the Binary Assets features.

**Description**

The Binary Assets window is launched from the Graphics Composer’s Asset menu.

Selecting the Add Binary File icon ( ![add binary file icon] ) opens the Import File dialog.

**Tool Icons:**

1: Add Binary File
2: Delete Selected Entries
This supports any formatted binary file. Developers can then add a custom-coded decoder to support the format implied by the imported file. (A future version of the GFX library will include a bin2code utility in support of this feature.)

MHGC Tools

The Tools menu supports managing all graphics events, using a global palette, and estimating heap memory usage.

Event Manager

This section provide information on the Event Manager.

Description

The Graphics Composer Event Manager provides a GUI interface to manage all of the events associated with a graphics application. In a general sense, an event is an action or occurrence that is processed by software using an “event handler”. Button pushes or keystrokes are widely recognized and handled events. Events related to a touch screen are commonly called “gestures”. This GUI allows the assignment of actions to events associated with graphics widgets and to events outside of the graphics library. Under the Graphics Composer Event Manager tab there are two sub-tabs, one for “Events” and a second for “Macros”.

“Events” under the first tab are generated from within graphics widgets and can manipulate the properties of screen widgets or set semaphores that engage with the rest of the application. “Macros” are executed outside of graphics widgets by other parts of the application. “Macros” allow the application to change widget properties or behavior.

Both “Events” and “Macros” event handlers can be built using collections of “Template” actions or using “Custom” developer-provided code. Most widget properties have an associated Template action that can be used to manipulate that property in an event handler (either “Event” or “Macro”). For more information on properties and related actions, see the discussion on the Properties Window below.

To explore these capabilities, let’s look at the Aria Quickstart project after the completion of the Adding an Event to the Aria Quickstart Demonstration Quick Start Guide.

Graphics Composer Events

The Graphics Composer Screen Designer shows that there is one layer and three widgets in this demonstration.
Of the three widgets shown above, only ButtonWidget1 can have events associated with it, one for button pressed and a second for button released. This can be seen in the Graphics Composer Event Manager window, which is available from the Tools menu:

The events shown under “ButtonWidget1” are mirrored in the widget’s properties. Selecting or clearing an event in one window does the same in the other window, thus enabling (selecting) or disabling (clearing) the corresponding event.

We can add a Check Box widget to the applications display and then use the Event Manager to assign actions to the widget’s events. A Check Box widget has two events, one for being “Checked” (i.e., selected) and another for being “Unchecked” (i.e., cleared). Enabling the “Checked” event then allows the selection of the action or actions for that event.

The Actions: sub-window has five tool icons for managing the actions associated with an event:
Clicking the Create New Action icon ( ) opens the Action Edit dialog.

If you select Custom and click Next, you will see the following dialog. Unfortunately, there is no C code error checking with this window. It just copies the code into libaria.c and libaria.h. If there is a problem with the code you will not know about it until you try to build your application. An alternative is just to type a comment such as /*My event goes here*/, generate the code, and then find out where this comment landed in the code. (Typically, inside libaria_events.c or libaria_macros.c) You can then write the action routine from within the MPLAB X IDE editor and compile just that file to debug the code written.

If you select Template, the Action Edit dialog will update, as follows. Select ButtonWidget1.

As shown previously, you next need to select the widget that you want to manipulate with this action. Note that the event originated with CheckBoxWidget1, but the event's action can manipulate any of the existing widgets. In this case, ButtonWidget1 has been selected. Clicking Next
will then bring up a list of the actions available in manipulating a button widget.

You can select the “Set Text” action, which will then change the button’s text property, followed by NEXT, which will open a dialog to select the text string for this action.

You can then select from the available (already defined) strings which text to use for the button’s text field. Press the Finish button to complete the definition of this action.

**Screen Events**

As shown previously, the Graphics Composer Event Manager, Events sub-tab supports screen events when the screen is visible (On Show) and hidden (On Hide). These events can define event handlers based on Template actions or Custom, user-defined code.

**Widget Events**

Not all widgets can generate an event. For example, a Label Widget has nothing to generate, it just sits there on the screen, labeling. Here is a list of the widgets that can generate an event:
- Button – Pressed and Released events
- Check Box – Checked and Unchecked events
- Draw Surface – Draw Notification event
- Image Sequence – Image Changed event
• Key Pad – Key Click event
• List Wheel – Select Item Changed event
• List – Selection Changed event
• Progress Bar – Value Changed event
• Radio Button – Selected and Deselected event
• Scroll Bar – Value Changed event
• Slider Widget – Value Changed event
• Text Field – Text Changed event
• Touch Test – Point Added event

Graphics Composer Macros

Macros implement event handlers for events that originate outside of graphics primitives such as widgets and are designed to change or manipulate widgets inside of the graphics part of an application. (Events that originate outside of graphics and don’t touch the graphics part of the application are outside of the scope of the Graphics Event Manager and are not discussed here.)

The following figure shows a simple example of a macro.

The toolbar for Macros has three icons.

Creating a new macro and selecting its actions is just like that of a widget event:

1. Create a new macro using the “Create New Macro” tool. The check box to the left of the new macro’s name enables/disables the macro. Clearing it removes the macro from the next code generation.
2. Select the new macro and edit it using the second icon (shown previously).
3. In the Actions: window, select Create New Action. An optional name can be provided in the Name: box. You can then choose to use a Template and select a predefined action or Custom to create a customized action.

4. If you chose a “Custom” action, proceed as discussed previous in Graphics Composer Events. When using templates the next step is to choose the target widget for the action. This choice is limited to those only the widgets in the currently “active” screen. If your application has multiple screens and the widget you are targeting is not part of the currently active screen you need to change the active screen.
   • Changing the active screen can be done by selecting the corresponding screen tab at the bottom of the Graphics Composer Screen Designer

   • Alternately, you can switch using the Graphics Composer Manager:Screens tab
5. After selecting the target widget for this macro, click Next button to select an action related to this widget. (Just as with template-based widget events.) The macro can contain more than one action, targeting more than one widget.

### Heap Estimator

Provides information on heap space allocation.

#### Description

Many parts of a graphics design are implemented using memory allocated from the application's heap space. Thus it is important to allocate sufficient memory for the heap. This tool can estimate heap usage by the allocation based on the widgets, layers, screens, and decoders currently in the design. (Note: Rerun the tool after changing the graphics design to assure that the heap allocation is right-sized for the application.)

When launching the tool from the Tools menu, the Heap Configuration window appears.

Clicking **Calculate** estimates heap usage. The following figure shows what occurs within the Aria Quickstart demonstration if the heap space is only 4096 bytes:
The Summary tab shows how the estimated heap requirements was derived by summing up all the sizes shown under the “Size (Bytes)” column. Note that the largest contribution comes from the screen requiring the largest heap allocation (in this case MainMenu).

If there is insufficient memory allocated to the heap, an exclamation point (!) appears in the window. If you hold your mouse pointer over this icon, the following message appears:

The current MHC heap value is not high enough to accommodate the estimated requirements of the graphics stack. Please adjust the value.

You can click Set MHC Heap Value to reset the heap allocation to match the estimated requirements. Selecting Add to MHC Heap Value adds the estimated heap requirements to the current heap value. (In the case above, this would change the heap allocation to 4096+10664 bytes.)

Alternately, you can set the heap allocation to a larger value by going to the MPLAB Harmony Configurator window, selecting the Options tab and setting the Heap Size within Device & Project Configuration > Project Configuration.

The Screen Details tab (from the Aria Showcase demonstration) shows screen-by-screen the heap space needed for each layer and widget on the screen selected.
Clicking the “Name” column will alphabetize the list. Clicking the “Size (Bytes)” column sorts the assets by size, with the largest at the top and smallest at the bottom.

This sub-tab can help in managing the application’s utilization of heap space. For example, excess use of cached backgrounds for widgets can become ruinously expensive, expanding the application’s need for heap well beyond the capabilities of the device. As an example, consider a screen label from the Aria Showcase demonstration.

The Heap Estimator tool shows that if caching is enabled for the label’s background, this widget requires 23699 bytes of heap to store the widget. Note that the label is twice the size of the text it contains, so one way of reducing the cost of the widget is to make it smaller, thereby reducing the number of background pixels that must be stored. If the label is resized, the heap allocation is reduced to 11688 bytes, which is a drop of approximately 50%. Finally, if the background is changed from “Cache” to “Fill” the widget only needs 188 bytes.

The lesson learned is to use Cache as a background only for widgets where it is absolutely necessary and to make the “cached” widgets as small as possible.

---

**Global Palette**

Provides information on the Global Palette features.

**Description**

The Global Palette window is launched from the Graphics Composer’s Asset pull-down menu.

Using a Global Palette enables frame buffer compression for the LCC graphics controller. It creates a 256 color look up table (LUT) and then changes the entire user interface design to adhere to that LUT. Frame buffers are stored as 8 bits/pixel (bpp) indices rather than 16-32 bpp colors. The display driver performs a LUT operation to change each LUT index into a color before writing to the display/controller memory. This enables the use of double buffering, without using external memory, on devices that could not support it before. It also supports single buffering on larger displays. Of course, running the LUT requires more processing on the host. Currently only the LCC graphics controller supports this feature. The Aria demonstration Aria Basic Motion is an example of how using a Global Palette greatly improves the efficiency and capabilities of a design.

You enable the Global Palette by clicking on the Enable Global Palette check box in the window or using the File > Settings menu. You can always disable the Global Palette. MHGC will then restore the project back to its original configuration.

What you get by enabling the Global Palette:
• 8bpp frame buffers. In the case of our most common demonstrations this means a 50% reduction in the size of the frame buffer.
• This also opens up the capability to support a single frame buffer for some larger displays.

What you give up by enabling the Global Palette:
• First and foremost - No Dynamic Colors. Dynamic colors are unlikely to match up with an entry in the global palette’s look-up table.
• No alpha blending capability. The level of alpha blending can be changed during run-time. (See No Dynamic Colors.)
• No JPEGs or PNGs. Again, no dynamic colors. All images in MGHC will be changed to the color mode of the project, and generated as Raw.
• No font anti-aliasing. Again, no dynamic colors. While the 8-bits/pixel for each glyph is known, the color of the text depends on the color scheme used, and color schemes can change at run time.
• Additional overhead when performing LUT (index->color) operations in the display driver.

The following figure shows the default “Global Palette” when Project Color Mode is set to RGB_888.

Window Toolbar

There are four icons on the toolbar:
• **Import From Image File** – Importing a global palette from an image file. Selecting this brings up the following warning. Images can be imported as a BMP, GIF, JPEG, and PNG (but not TIFF).

• **Auto-Calculate Palette** – Calculates a new palette using the current design. Selecting this brings up the following warning.
Selecting **Yes** opens a status window that shows the progress made in selecting a palette of 256 colors. This can be a lengthy operation, but it will effectively generate a palette better tailored to the design. However, extreme (or rare) colors will be changed to nearby, more-plentiful colors, thereby eliminating some of the contrast in images. Whites will tend to darken and blacks lighten. This can be remedied by editing the calculated palette to whiten the whites, darken the blacks, and make other colors closer to the original. This of course may increase the posterization of the image, but that is a natural trade-off in using only 256 colors.

3. **Reset to Default** – This returns the Global Palette to its default values, which opens the Reset Global Palette dialog.

4. **Enable Global Palette** – This performs the same function as **File > Settings: Using a Global Palette**. Selecting this opens the Enable Global Palette Mode warning.
Widget Colors

Provides information on widget coloring.

Description

Widget Colors

Widget coloring can be customized by creating additional color schemes and assigning these customized schemes to a subset of the widgets uses. For example, a ButtonColorScheme could be customized and used only for Button Widgets.

To help highlight the different colors available for each widget, a “CrazyScheme”, with extreme contrast among the 16 available colors, was used as the color scheme for each widget:

<table>
<thead>
<tr>
<th>Scheme</th>
<th>Crazy/Scheme</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base</td>
<td>[192, 192, 192]</td>
</tr>
<tr>
<td>Highlight</td>
<td>[255,0,0]</td>
</tr>
<tr>
<td>Highlight Light</td>
<td>[255,255,255]</td>
</tr>
<tr>
<td>Shadow</td>
<td>[255,255,0]</td>
</tr>
<tr>
<td>Shadow Dark</td>
<td>[192,192,0]</td>
</tr>
<tr>
<td>Foreground</td>
<td>[0,255,0]</td>
</tr>
<tr>
<td>Foreground Inactive</td>
<td>[0,128,0]</td>
</tr>
<tr>
<td>Foreground Disabled</td>
<td>[0,64,0]</td>
</tr>
<tr>
<td>Background</td>
<td>[255,255,255]</td>
</tr>
<tr>
<td>Background Inactive</td>
<td>[192,192,192]</td>
</tr>
<tr>
<td>Background Disabled</td>
<td>[128,128,128]</td>
</tr>
<tr>
<td>Text</td>
<td>[0,0,0]</td>
</tr>
<tr>
<td>Text Highlight</td>
<td>[0,0,255]</td>
</tr>
<tr>
<td>Text Highlight Text</td>
<td>[224,224,224]</td>
</tr>
<tr>
<td>Text Inactive</td>
<td>[178,178,178]</td>
</tr>
<tr>
<td>Text Disabled</td>
<td>[96,96,96]</td>
</tr>
</tbody>
</table>

Use this color scheme to help identify the relevant colors for the widgets listed below.

The left column shows the coloring assignments for a Bezel boarder. The right side shows Line/No Border color assignments.
Code Generation

This topic describes using the graphics composer to generate code.

Description

MPLAB Harmony Graphics Composer data is generated the same way as the rest of the project within MHC through the Generate button.

libaria_harmony.h/c – These files provide the interface that binds libaria to the overall MPLAB Harmony framework. They contain the implementations for the standard state management, variable storage, and initialization and tasks functions. If the touch functionality is enabled then the touch bindings are also generated in libaria_harmony.c.

libaria_init.h/c – These files contain the main initialization functions for the library state and screens. The header file contains all predefined information for the library state including screen IDs, schemes, and widget pointers. The main initialization function initializes all schemes and screens, creates all screen objects, and sets the initial state of the library context. As each screen must be capable of being created at any time, each screen has a unique create function that can be called at any time by the library. The libaria_init.c file contains these create functions.

libaria_event.h/c – The event files contain the definitions and implementations of all enabled MHGC events. Each event implementation will contain all generated actions for that event.

libaria_macro.h/c – The macro files contain the definitions and implementations of all defined MHGC screen macros. A macro is similar to an event in that it can contain actions. However, it is meant to be called from an external source such as the main application.

libaria_config.h – This file contains configuration values for the library. These are controlled through settings defined in the MHC settings tree.

Saving and Loading Data

This topic describes using the graphics composer to save and load data.

Description

The graphics composer saves and loads its data into the configuration.xml file of the MHC configuration. This file is always located within <install-dir>/apps/feature/demonstration_name/firmware/src/system_config\configuration_name. The saved data is loaded when MHC starts and is saved when the configuration is saved through the Save or Save As dialog boxes.
Importing and Exporting Data

This topic provides information on importing and exporting graphics composer-related data.

Description

The MPLAB Harmony Graphics Composer provides the capability for users to import and export graphics composer-related data. The user can export the state of an existing graphics composer configuration, import another graphics composer configuration, and import projects from the Graphics Display Designer X (GDD X) utility.

The import and export interfaces are located in the Configuration dialog of the MPLAB Harmony Configurator, which is accessible from the Options tab.

Importing Data

To import data into graphics composer, click Import from the main window toolbar. The Import dialog box is displayed.

The user can choose to import either GDD X or graphics composer data. Upon selecting a format and clicking Import, a path dialog will appear and the user can browse to either a graphics composer XML file or a GDD X project file.

⚠️ Warning

Importing data will remove all currently existing graphics composer data.

Exporting Data

To export a Composer configuration:

1. Click Export.
2. Select MPLAB Harmony Graphics Composer from the list and click Export.
3. Select the file path where the exported data should be placed and click Open. The current graphics composer data will be written into this file.